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Lernziele — Was kann ich von diesem Handbuch erwarten?

In diesem Handbuch wirst du mit der kostenfreien Software QGIS vertraut gemacht.

Nach dem Bearbeiten dieses Handbuchs kannst du:

1. Beschreiben, was ein GIS ist und wofiir es angewendet wird.
2. Diefiir dich geeignete QGIS-Version eigenstdndig herunterladen und installieren.
3. Eine Referenzkarte und Satellitendaten in QGIS einladen.

4. Zwischen verschiedenen Datentypen und deren Eigenschaften innerhalb des GIS
unterscheiden.

5. Ein addquates Koordinatensystem auswdhlen.
6. Die Darstellung von Satellitendaten anpassen.
7. Mit Hilfe verschiedener Bildkandle umweltanalytische Indizes berechnen.

8. Vektordaten aus vorhandenen Daten in QGIS einladen, aus einem Web Feature
Service gewinnen und durch Abdigitalisieren generieren.

9. Bildausschnitte extrahieren und abspeichern.
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Was ist QGIS und wie installiere ich es?

QGI/S " ist ein freies Geoinformationssystem, mit dem du Geodaten, also Daten mit
Raumbezug, erfassen, darstellen, analysieren und weiterverarbeiten kannst, zum
Beispiel Satellitendaten. Die Open-Source-Software ist kostenlos und darf unter der
General Public License fiir alle Zwecke genutzt werden, auch kommerziell.

Du findest QGIS unter https://www.qgis.org/de.

Klicke auf QGIS ENTDECKEN, um mehr {iber das Programm zu erfahren.

Zum Herunterladen des Programms klicke auf Jetzt herunterladen.

QGIS ENTDECKEN FUR BENUTZER MITMACHEN DOKUMENTATION — Deutsch v Ab b -1

Zeit bis zum freeze 2021-09-10 12:00:00 UTC 10d 4h 28m
Zeit bis zur Paketierung 2021-10-22 12:00:00 UTC 52d 4h 28m

QG l S Zeit bis zum nachsten Pointrelease 2021-09-10 12:00:00 UTC 10d 4h 28m

Ein freies Open-Source-Geographisches-Informationssystem

QGIS 3,20 Odense

(<)

hds been released!

New release: 3.20!

Hole das far lhr Betri tem und lesen Sie das

Erstellen, bearbeiten, i lysieren ra icher Information unter Windows, Mac, Linux, BSD und Mobilgerdten

Fiir Ihren Desktop, Server, im Webbrowser und als Bibliothek zur Entwickiung

Jetzt herunterladen QGIS unterstitzen

Du brauchst Administratorrechte, um QGIS zu installieren.

Auf der folgenden Seite findest du unter dem Tab Installationsdownloads verschiedene

Downloadpakete zu den jeweiligen Betriebssystemen. Wahle eines der eigenstandigen
Installationspakete fiir dein Betriebssystem aus den verfiigbaren Optionen. Du kannst
dabei jeweils zwischen der aktuellen Version und der langfristig stabilen Version wahlen.
Wir empfehlen die langfristig stabile Version (Long Term Release) bzw. ,,Version mit
Langzeitunterstiitzung®, da hier keine Programmierfehler mehr auftreten sollten und ein
vollstandiges Handbuch bereit gestellt wird. In unseren Schulungen und Handbiichern
benutzen wir durchgehend die Version QGIS 3.16 Hannover. Wenn du eine andere QGIS-
Version benutzt, kann es bei einigen Schritten zu leichten Abweichungen kommen.


https://www.qgis.org/de
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Achte bei einer Windows-Installation auf den richtigen Systemtyp (32bit oder 64bit). Den
Systemtyp deines Computers findest du mit dem Windows Explorer unter Dieser PC >

Eigenschaften im Abschnitt System.

NEZWErKadaresse ninZurugen

Abb. 2
IV 3 Dieser PC I -
— Loschen

> 3 30-Objekte Umbenennen

> [ Desktop -
Speichere die Datei und 6ffne sie nach dem Download. Folge dann den Anweisungen, die
dich durch die Installation fiihren. Offne dann z.B. iiber das Windows Startmenii das
Programm QGIS Desktop. Hast du eine dltere QGIS-Version, wahle QGIS mit GRASS.

Q SHR GRPHX Abb. 3

~ Qeis31613 ~ ) @ G 5 «w ¢

@’ GRASS GIS 7.8.6

& 0sGeodw shell CVNCIN 3 ¥
I Q QGIS Desktop 3.16.13 I e o -

@\ Qt Designer with QGIS 3.16.13 custo...

Q Q@ O 5

@ SAGA GIS 7.8.2

O san T mE
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Wie ist die Bedienoberflache von QGIS aufgebaut?

Nachdem du das Programm gedffnet hast, siehst du die Benutzeroberflache von QGIS,
die in Meniileiste, Werkzeugkdsten, Bedienfelder und ein Kartenfenster gegliedert ist.
Ganz oben erscheint die Meniileiste und darunter diverse Werkzeugkdsten mit
verschiedenen Symbolen. Welche Bedienfelder und Werkzeugkdsten dir in QGIS
angezeigt werden, kannst du selbst bestimmen. Per Rechtsklick auf den Meniibereich
oder im Menii unter Ansicht > Bedienfelder bzw. Werkzeugkdsten kannst du die Auswahl

an deine Bediirfnisse anpassen.

Viele Unterpunkte des Meniis lassen sich auch per Tastaturkiirzel oder {iber das
entsprechende werkzeugsymbol aufrufen.

- [m] X

Projekt Bearbeiten Layer Einstellungen Erweiterungen Vektor Raster Datenbank Web Netz Verarbeitung Hilfe

m - . 3 * . . r_‘ -

£} Neue 3D-Kartenansicht Strg+AltsM

] El

el @ | 12 T - -
5 ) are vershi L= Elx -IY ®
5.4 e % :' Karte zu gewahlten Objekten verschieben
rowser ® Hineinzoomen Strg+Alt++
ORT*teo & Hinaus zoomen Strg+Alt+-
7 Favariten Objekte abfragen Strg+Umschalt+1
» 1" Raumliche Les
» [&) Home
y I 2 Statistische Zusammenfassung =8 Flache messen rg+Umschalt+.
» Oy 13 volle Ausdehnung (E) Strg+Umschalt+F | @ Winkel messen
» [ HA .
Zu ausgewdhliten Objekten zoomen Strg+)
» DO £ zuausg ) 9
v [Isa Auf Layer zoomen
s i o g 4002,

In der Meniileiste findest du alle wichtigen Optionen und Werkzeuge. Uber die einzelnen
Meniipunkte kannst du z.B. die Projekteigenschaften einstellen, zusatzliche

Erweiterungen (engl. plugins) installieren (vgl. S.10: Wie lade ich eine Referenzkarte?)

oder die Verarbeitungswerkzeuge als Fenster 6ffnen, das alle Werkzeuge iibersichtlicht
darstellt und eine einfache Suche erméglicht.

(3 Unbenanntes Projekt — QGIS - [} >
Bearbeiten Ansicht Layer Einstellungen (ZWEENNEEY Vektor Raster Datenbank Web | Netz | QIRZIGITEY  Hilfe
) Neu Strg+N & Erweiterungen verwalten und installieren... |_‘ Werkzeugkiste n Strg+Alt+T CJ »
Neu aus Vorlage » '*;& Grafische Medellierung.., Strg+Alt+G ¢
 Offnen (g)... Strg+ 0 x (%) Protokoll (h}... Strg+Alt+H
Offnen aus » |?|£rgebnisanzaige Strg+Alt+R
Zuletzt verwendet » ) Objekte insitu andern
SchlieBen Verarbeitungswerkzeuge ‘
[ Speichemn Strg+S *ﬁ"i e @ | 3 | é\)
Speichern als... Strg+ Umschalt+5 | Q such .
Speichern als ' 4 @ Kirzlich verw‘éndat =
Zuriicknehmen.., » Q Dateiwerkzeuge
B Eigenschaften... Strg+Umschalt+P 3 @ Datenbank

Auf der linken Seite der QGIS-Oberfliche siehst du im Browser-Bedienfeld (1) alle
Ressourcen, die dir in QGIS zur Verfiigung stehen, deine Dateiordner und Laufwerke,
Web-Services, Lesezeichen und Favoriten. Von hier aus kannst du per Drag & Drop direkt
Daten in die Kartenansicht (2) ziehen; in diesem Bereich werden die Daten dann

Abb. 4

Abb. 5
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visualisiert. Hier kannst du einzelne Elemente ansehen und die Sicht auf die Daten durch
Ein- und Auszoomen anpassen.

Links unten im Ebenen- bzw. Layer-Bedienfeld (3), erscheinen alle eingeladenen Daten
als tibereinander liegende Ebenen (engl. layer). Durch Rechtsklick auf einen Layer kannst
du die Eigenschaften (auch visuelle Darstellung) und Attributtabellen einsehen und
bearbeiten oder einen Layer kopieren, bearbeiten oder [6schen. Je nach Datentyp (Raster-
oder Vektordaten) werden andere Eigenschaften angezeigt.

Ganz unten befindet sich noch eine Statusleiste (4), welche die wichtigsten Eckdaten zu

deiner aktuellen Kartenansicht kompakt zusammenfasst, wie beispielsweise das
verwendete Koordinatenbezugssystem, Koordinaten, Maf3stab und die aktuell im Projekt
verwendete VergroBerung der Ansicht.

(&) Unbenanntes Projekt — QGIS - m] X
Projekt Bearbeiten Ansicht Layer Einstellingen Erweiterungen Vektor Raster Datenbank Web Netz Verarbeitung Hilfe Abb. 6
DpERRY LA HP PRuBatNOR E:=-9&-m-
A@Vaom @ > =g g queasgsg QAR 2 H
Browser Verarbeitungswerkzeuge 5
QRET™HO * 8 LY
@ rostis E Q suche
P mssaL » (D Kardich verwendet =
@ Oracle » () Dateiwerkzeuge
DB2 » (G} Datenbank ’:
- G WMswMTS . > _
V< ac Ergebnisanzeige @)
» =C orthofotos
Layer |
o i e T 153 i |

e
Zu suchender Typ (Strg+K) 4 Koordinate | 1.958,-0.224 Mafstzb | 1:2372780 | = VergriBerung 100% | Drehung | 0,0°¢ = | V| Zeichnen EP5G:4326
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Wie lege ich ein QGIS-Projekt an?

Links liber der Meniileiste steht jeweils der Name des aktuellen Projektes, denn die Arbeit
in QGIS wird in einer Projektdatei organisiert. Solange du nichts abgespeichert hast,
bleibt dein aktuelles Projekt als Unbenanntes Projekt — QGIS unbenannt. Lege also eine

neue Projektdatei an und sichere anschlieend dein Projekt. Klicke dazu a) im
Kartenfenster auf Neues leeres Projekt oder b) die Tastenkombination STRG+N oder ¢) im

Menii auf Projekt > Neu oder d) auf das Seiten-Symbol. Zum Speichern kannst du z.B. das
Disketten-Symbol verwenden, aber auch hier gibt es wieder verschiedene Wege. Gib
anschliefend, einen Dateipfad und -namen an.

(2} Unbenanntes Projekt — QGIS — m] x
Bearbeiten Ansicht Layer Einstellingen Erweiterungen Vektor Raster Datenbank Web Netz Verarbeitung  Hilfe
= =] & os [dm - — . .

DBl RS O, RP VA BatIIOR ¥ I m-G ku
eV, %@ - ——————
Browser ®®  Nachrichten

O_T®O <

‘33 Favoriten =

> ]' Réumliche Lesezeichen

+ @] Home

r O A message from Marco Bernasocchi, incoming QGIS Project

v O Chairman

y [ Ha wm ] i

v DO <1 . Dear QGIS community, we recently completed the 2020 PSC election process -
R b =
e . Projektvorlagen

o e T -FADO

Neues leeres Projekt
EPSG:4326 - WGS 84
Eine neue QGIS-Version ist verfiighar: Vist https://downlosd.anis.ons to get your copy of version 3.22.6

| Q zu suchender Typ (stra+6) | Fertig sordinat B w|uammes |~ | @ aroben| 0% BENZE [2] vl zeitmen  Brerscienzs @

Vermeide generell Leerzeichen in Dateinamen und Dateipfaden. Diese kdnnen in
QGIS bei verschiedenen Verarbeitungswerkzeugen zu unerwarteten Fehlern fiihren.

Wenn du dein QGIS-Projekt das nachste Mal 6ffnest, wird alles wieder genau so aussehen
und angeordnet sein, wie zum Zeitpunkt des letzten Speicherns; alle Layer (sofern sie
nicht aus ihren Ordnern verschoben oder geléscht wurden) und Layereigenschaften, das
Projekt-KBS, die letzte Kartensansicht, etc. werden gespeichert.

Abb. 7
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Wie lade ich eine Referenzkarte?

Basiskarten wie topographische Karten, StraBenkarten oder weltweit flaichendeckende
Satellitenbildkarten dienen der Orientierung bei der Arbeit mit Geodaten in einem GIS,
denn sie setzten deine Daten in einen geografischen Kontext. Oft werden sie auch als
Kartengrundlage genutzt, um andere Daten ansprechend zu visualisieren.

Einen sehr einfachen Weg diese Basiskarten als Hintergrund in QGIS einzuladen,
ermoglicht die Erweiterung QuickMapServices. Um sie in QGIS zu integrieren, 6ffne im
Menii Erweiterungen > Erweiterungen verwalten und installieren, nutze die
Suchfunktion und wadhle QuickMapServices aus der Ergebnisliste aus. Klicke dann auf

Erweiterung installieren.

X

@ Erweiterungen | Alle (857)

‘ Alle O quickmap a

Fal nctal MapTiler - kM S - @
stalliert
R nstatie T QuickMapServices
Nicht installiert Easy to add basemaps
i Neu Easy to use list of services and search for finding datasets and basemaps. Please contribute
new services via http://gms.nextgis.com! Developed by NextGIS.
T+ Aus ZIP installieren oy oy iy A

U 886 Bewertung(en), 3439812x heruntergeladen

ﬁ Einstellungen

Tags wfs, wms, openstreetmap, osm, service, tms, geojson,
internet, gms, basemap

Weitere Informationen Homepage Fehlerverfolgung Coderepositorium
Autor NextGIS
Verfiigbare Version (stabil) 0.12.29 aktualisiert um Di Mrz 15 04:48:18 2022

Alle zktualisieran Erweiterung installieren

| schicgen || e |

Du findest QuickMapServices daraufhin unter dem Meniipunkt web bzw. als QMS-Symbol in
der Werkzeugleiste. Wahle osmMmund osm Standard fiir die gewohnte OpenStreetMap-Karte.

Projekt Bearbeiten Ansicht Layer Einstellungen Erweiterungen Vektor Raster Datenbank etz SCP Verarbeitung  Hilfe

= B Y o 87 —~ _ ] =

DEEmEY QPR 1 F Q) e # Z m- M

ﬂ @ V; ﬁ) L) @ . 2 o | 1% MapSurferNET ) @ 2
Browser @069 P_NASA
LeT*eo jj

'+ Favoriten E T A
v 1" Raumliche Lesezeichen (€} Search QMS (&) OSM TF Landscape
v [&] Home ) Add to Search (B 0SMTF Outdoors
[N @ Set proper scale () OSM TF Transpart Dark
v Oz

E‘h GeoPackage @ Settings (@ 05M Transpartation

# Spatialite @ About e OSM Veloroad

@ rostals d

P mssaL

@ Oracle ~
Layer

¢ @O TO-BADL
~ W/ OSM Standard

Wenn du weitere Basiskarten haben mochtest, kannst du unter web » QuickMapServices »
Settings > More services > Get contributed Pack > Speichern zusdtzliche Karten

hinzufiigen. Du findest dann unter QuickMapServices eine Vielzahl verschiedener
Basiskarten.

Abb. 9
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Wie lade ich Satellitendaten in QGIS ein?
Importieren einer Sentinel-2-Szene
Sentinel-2-Daten und andere Satellitendaten kannst du kostenfrei {iber viele

verschiedene Datenportale beziehen, z.B. liber das deutschsprachige Portal CODE-DE °.
In unsem SAPIENS-Handbuch Passende Satellitendaten finden — Das Datenportal CODE-
DE? stellen wir CODE-DE vor und zeigen dir, wie du damit Satellitendaten anschauen und

herunterladen kannst.

Die Sentinel-2-Satelliten nehmen mit dem Multispektral-Instrument (MSI) Daten in
verschiedenen Wellenldngenbereichen auf und speichern sie in 13 verschiedenen

Kandlen bzw. Bandern.

Abb. 10
Sichtbares Licht
' Sichtbares und Nahes Infrarot (VNIR)
Kurzwelliges Infrarot (SWIR)
10m
rni | I 11T
1 2 3 4 56 7 8 8a 9 10 11 12
400 nm 600 nm 800 nm 1000 nm 1200 nm 1400 nm 1600 nm 1800 nm 2000 nm 2200 nm
Lade die benotigten Bander in dein QGIS-Projekt. Navigiere dazu zum Speicherort deiner
Sentinel-2-Daten und entpacke ggf. die im Zip-Format vorliegenden Satellitendaten. Die
Bilddaten sind bei Level 2A-Produkten immer im Ordner GRANULE bzw. IMG_DATA abgelegt.
Wihle den Ordner mit der héchsten Auflosung (R1om).
Fiir eine Visualisierung in Echtfarben bendétigst du die Sentinel-2 Bander rot, griin und
blau, also 4, 3 und 2. Zusatzlich brauchst du Band 8 fiir die Darstellung als
Falschfarbenbild und zur Berechnung von Vegetationsindizes. Markiere mit gedriickter
STRG-Taste die Bander B02, Bo3, Bo4 und B8 und ziehe sie dann per Drag & Drop mit
gehaltener linker Maustaste in das QGIS-Programmfenster. Lass dann die Maustaste los.
X Abb. 11
Start Freigeben Ansicht hd e
~ v P « |MG_DATA » R10m v | D 2 "R10m" durchsuchen
S2A_MSIL24_20190726T102031_M0213_R065_T33UUV_20190726T125507.5, ™ MName -
AUX_DATA
DATASTRIP ] T33UUV_20190726T102031_B02_10m,jp2
] T33UUV_20190726T102031_B03_10m,jp2
L2A_T33UUV_A021369_20190726T102028 4] T33UUV_20190726T102031_B04_10m.jp2
AUX DATA «f] T33UUV_20190726T102031_B0G_10m jp2
T33UUV_20190726T102031_TCI_10m,jp
<] T33UUV_20190726T102031_WVP_10m.jp2
| RiOm | '
R20m &
RE0m v < | 3
TElemente 4 Elemente ausgewdhlt (450 MB)  Status: @ Online [~ E‘ =l
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Satellitendaten sind Rasterdaten, eine der zwei Geodatentypen, mit denen im GIS
gearbeitet wird. Du kannst die Bander alternativ also auch iiber den Meniipunkt Layer »

Layer hinzufiigen > Rasterlayer hinzufiigen> ... einladen.

B cowse Abb. 12

IFOWEET QIIE"tVD

. b4 : Vektor

'@ Datej | Protokol: HTTP(S), Cloud, etc.
</ Quelle
& Metz
Rasterdatensitze
Getrennte Texte
*

Navigiere zum Speicherort der Bilddaten, wahle die bendtigten Bander aus mit Hilfe der
SHIFT- oder STRG-Taste, bestdtige deine Auswahl iiber die O0ffnen-Schaltflache und
anschlieBend die Hinzufiigen-Schaltflache.
Die Bander erscheinen jetzt als iibereinandergelagerte Layer im Kartenfenster rechts. Im
Layer-Fenster links sind alle in der Karte enthaltenen Layer aufgelistet, wobei ein weiter
oben liegender Layer alle darunter liegenden iiberdeckt.
Verdndere die Layerreihenfolge, indem du einzelne Layer bei gedriickter Maustaste an
eine andere Position ziehst und losldsst. Eine diinne Linie markiert die Stelle, an der ein
Layer beim Loslassen abgelegt wird. Mit den Hiakchen bestimmst du die Sichtbarkeit der
Layer.
Klicke mit der rechten Maustaste auf einen der Sentinel-Layer und wdhle Auf den Layer
zoomen aus, um den Bildausschnitt anzupassen oder zoome und verschiebe die Karte mit
der Maus, bis du die gesuchte Stelle erreichst.

Projekt Bearbeiten Ansicht Layer [instellungen Erweiterungen Vektor Raster Datenbank Web Netz SCP  Verarbeitung Hilfe

I EERRH (PP LB PP BLAR &6 -5 & G S#Is 90 Abb. 13

RQV.Z % B - e ® ~ B

B"m:c T*1o - L “ = 1 N

Favonten N W Gpete
» " Raumliche Lesezeichen i
(B B s R e S T

» Dz .
@ GeoPackage R
/£ Spatialite A
W@ postcls
» mssaL \ Wt
@ Oracle ClaEr, LV,

Layer @5

o 3 ® Y

M Auf den Layer zoomen
©2 In der Ubersicht anzeigen
Layer kopieren
Layer umbenennen
 Auf eigene Auflésung zoomen (100%)
Strecken mit aktueller Ausdehnung

B O = wmo - -

s 7 ] Layer duplizieren

3 Layerloschen...
Datenquelle andern...
MaBstabsabhangige Sichtbarkeit des/der Layer setzen...
KBS setzen » By

Teorpiin, ., 3

0
4
T
0
7 1 \
T Teetiiary \

Exportieren » |
Siie , [ssosss087975 | R mabsteb| 1:793391 |~ | @ VergroBeung| 100% 2| orehung [0,0° 3|V zedmen BEsmisne @
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Anpassen des Koordinatenbezugssystems

Mit dem Koordinatenbezugssystem (KBS) wird festgelgt, mit welcher Art von
Koordinatensystem, Erdkérper-Modell und Kartenprojektion die dreidimensionale Welt in
einer zweidimensionalen Karte dargestellt werden soll. Oft stammen Daten, die fiir ein
GIS-Projekt bendtigt werden, aus verschiedenen Quellen und besitzen unterschiedliche
KBS. Auch dem QGIS-Projekt selbst kann ein KBS zugewiesen werden. Fiir ein optimales
Ergebnis ohne grofRere Verzerrung solltest du ein geeignetes KBS auswahlen und das KBS
deines Projektes an die darzustellende Region bzw. deine eingeladenen Daten anpassen.
Je nach Art der geplanten Analyse, der rdumlichen Ausdehnung des Arbeitsgebietes und
oft auch abhdngig von der Verfiigbarkeit der Daten eignen sich bestimmte
Kartenprojektionen und Koordinatenbezugssysteme mehr oder weniger fiir ein
bestimmtes Projekt.

Da es sehr viele verschiedene KBS gibt, nutzt man zur Unterscheidung die EPSG-
Codes. Die vier- bis fiinfstelligen Codes, die urspriinglich von der European
Petroleum  Survey Group Geodesy, also Europdischen Ol- und
Gasforderunternehmen entwickelt wurden, dienen der eindeutigen Bezeichnung
von Koordinatenreferenzsystemen und Kartenprojektionen weltweit.

Ein Referenzsystem, das fiir Darstellungen iiber Deutschland hdufig verwendet wird, ist
z.B. das amtliche Koordinatenbezugssystem EPSG:25832 bzw. EPSG:25833. Weitere
typische Georeferenzierungen findest du hier:

https://gdz.bkg.bund.de/index.php/default/georeferenzierungen

Meist nimmt das Projekt automatisch das KBS der Daten an, die man zuerst einlddt. Fiigt
man dann weitere Daten hinzu, die ein anderes KBS besitzen, werden sie augenblicklich
in das bestehende Projekt-KBS reprojiziert. Das ist praktisch, kann aber u.U. die
Perfomance des Programmes schwachen und zu fehlerhaften Prozessierungen fiihren.
Achte also am besten darauf, dass alle Layer im Projekt ein -einheitliches
Koordinatensystem besitzen und neu eingeladene Layer immer in das gewiinschte KBS
tiberfiihrt werden.

Bei der Arbeit mit Satellitendaten hat sich dabei die Praxis bewdhrt, das KBS der
Satellitendaten zu verwenden und alle anderen Daten in dieses KBS zu reprojizieren,
denn das Umprojizieren von groflen Rasterdaten ist weitaus zeitaufwandiger und
fehlerbehafteter als das Reprojizieren von Vektordaten (vgl S.32: Reprojizieren von
Vektordaten).

Du kannst das Projekt-KBS aber auch jederzeit neu definieren. Die entsprechende
Dialogbox 6ffnest du im Menii unter Projekt > Eigenschaften > KBS oder mit einem Klick

auf die EPSG-Schaltflache rechts unten in der Statusleiste von QGIS.

Koordinate | 1073319,5082517 | § Mafistab | 1:793301 |~ | G VergréBerung| 100% |2| prehung [0,0¢ |2 V] zsichnen [ Abb. 1
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In unserem Fall hat das Projekt automatisch das KBS der OSM-Basiskarte angenommen,
wir mochten es aber auf das Bezugssystem der Satellitendaten einstellen. Die
Sentinel-2-Daten sind im WGS84-UTM-System referenziert. Unsere Sentinel-2-Szene liegt
in der UTM-Zone 33N, das KBS ist EPSG:32633. Gib den EPSG-Code 32633 in die Suchleiste
bei Filter ein, wdhle das KBS aus der Liste unter Vordefinierte Koordinaten-

bezugssysteme aus und klicke auf oK.

Welches KBS ein Layer besitzt, kannst du mit einem Rechtsklick auf den Layer »
Layereigenschaften » Information herausfinden oder indem du einfach deinen

Mauszeiger kurz iber dem Layer im Layer-Bedienfeld ruhen ldsst.

» Projekteigenschaften | KBS x Abb. 15

Koordinatenbezugssystem (KBS)
%, Allgemein Keine Projektion (oder unbekannte/nicht-Erd-Projektion)
. ’ A
a Metadaten Fllterl 32633 @ l
Kiirzlich benutzte Koordinatenbez st
Koordinatensystem Autoritats|D
WGES 84/ UTM zone 33N EP5G:32633
t Vorgabestile
==
BE Datenquellen
1 4
E Bezichungen _ ~
3] Vordefinierte Koordil yst Veraltete KBS verbergen
Variablen Koordinatensystem AutoritatsID

d B Prajiziertes Koordinatensystem

,@ Makros -
WGES 84/ UTM zone 33N EP5G:32633 I
& qois serve [ . < ’

WGS 84 [ UTM zone 33N

WKT
PROJCRS["WES &4 / UIM =zone 33NH",
BRSEGEOGCRS["WGES 854",
DATUM["World Geodetic System

-
Tmman

p Datumstransformationen

| Abbrechen || Anwenden || Hilfe

Du siehst nun die Sentinel-Kacheln in ihrer quadratischen Ausdehnung von 100 x 100 km.
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Wie kann ich die Satellitendaten farbig darstellen?

Umwandeln der Satellitendaten in ein Mehrkanalraster

Um aus den einzelnen Bdndern ein farbiges Multikanalbild und verschiedene
Bandkombinationen zu erstellen, miissen die Bdnder in einem einzigen Raster
zusammengefasst werden. Nutze dazu die Funktion Virtuelles Raster generieren im
Menii unter Raster > Sonstiges. Alternativ kannst du mit Raster > Sonstiges > Verschmelzen
auch ein reales Raster aus Einzelbdndern erzeugen. Je nach Anzahl der Datenséatze und
deren Auflésung nimmt das Verschmelzen aber wesentlich mehr Zeit und Speicherplatz
in Anspruch. Ein virtuelles Raster wird dagegen sehr schnell generiert. Bei Bedarf kann
man jederzeit aus einem virtuellen Raster {iber Rechtsklick > Exportieren > Speichern

als.. eine physische Rasterdatei erzeugen.

Ein virtuelles Raster ldasst sich wie ein normaler Rasterlayer bearbeiten, wobei die
Originaldateiein der einzelnen Bander nicht geléscht oder verschoben werden diirfen.
Denn die einzelnen Originaldateien werden im Hintergrund beibehalten; es entsteht
lediglich eine Katalog-Datei in Textformat. Solange die Dateiverkniipfungen zu den
Quelldaten des Layers erhalten bleiben, diese also nicht verschoben oder geléscht
wurden, kannst du den virtuellen Layer immer wieder nutzen.

Beim Generieren des virtuellen Rasters wird QGIS die Bander 2, 3, 4 und 8 in Kanal
1, 2, 3 und 4 umbenennen, wobei das Band an erster Stelle zu Kanal 1 wird, das
Band an zweiter Stelle zu Kanal 2, usw. Beachte daher die Reihenfolge bei der
Anordnung der Bander, um spater die Zuordnung nachvollziehen zu kénnen.

Verdndere gegebenenfalls die Reihenfolge der Bander mit Hilfe der Maus durch
Anklicken, Verschieben und Loslassen. Durch das Offnen der VRT-Datei in einem
Texteditor kannst du die Dateipfade sehen, die zu den Originalbandern verweisen
und daran auch ablesen, welches Band welchem Kanal zugeordnet wurde.

Wihle unter Input Layers ... die Bander 2 (blau), 3 (griin), 4 (rot) und 8 (Nahes Infrarot)
mit den entsprechenden Hakchen aus und klicke ok. Setze die gewiinschte Auflésung
unter Resolution auf Highest. Achte darauf, dass das Hakchen bei place each input file
into a separate band gesetzt ist, damit die Farbkanalkombination des Rasterbildes

spadter verandert werden kann.

Das virtuelle Raster wird nur tempordr angelegt, wenn du unter virtuell » [In
temporarer Datei speichern] nichts angibst, d.h. dein Layer geht verloren, sobald

du dein QGIS-Projekt schliefit. Mochtest du spater wieder darauf zuriickgreifen,
solltest du liber ... » in Datei speichern eine Ausgabedatei anlegen.
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Du solltest auch das Hakchen bei 0ffne Ausgabedatei nach erfolgreicher Ausfiihrung
setzen, so dass du dein Ergebnis sofort in der Karte sehen kannst. Klicke dann auf Starte
und schlief3e den Dialog, nachdem das Raster generiert wurde.

G’l Virtuelles Raster generieren > Abb. 17
- - » Mehrfachauswahl
Parameter Protokoll B O5M Standard [EP5G:3857] Alle wahlen E
Input layers v [T320UV_20190726T102031_B02_10m
- — v IUUV_20190726T102031_B0O3_10m Auswahl aufheben -
0 Elemente ausgewahlt | [|¥//T33UUV_20190726T102031_BO4_10m -
I V|| T33UUV_20190726T102031_B08_10m | Auswahl umschalten
Highest F Dateifen) hinzufigen... | | | +
Iaoe each input file into a separate band Verzeichnis hinzufiigen...
Allow projection difference | OK |
p Fortgeschrittene Parameter q ¥ Abbrechen
Virtuell

[In temporarer Datei speichern]

Oiffne Ausgabedatei nach erfolgreicher Ausfithrung
GDAL/OGR. Aufruf

gdalbuildvrt -resolution highest -separate + nearest -nput_file_list C:Users fanco/AppData/Local/Temp/
processing_35d 787148 11042 2daf1929647991209¢,7a 1ecbec0da9435f8 5898 febcle4es 5/buildvrtInputFiles. et C: /Users/anco/
AppData /Local/Temp/processing_95d 78748 11042 2daf19 2964799 1209¢/89eb 7d 35b3a64cb48e 570dc 7 3f43ffe 9 /OUTPUT  urt

0% Abbruch

Als Batchprozess starten. . Schliefien Hilfe

Der virtuelle Layer erscheint im Layer-Bedienfeld unter dem Namen Virtuell.

2 *QGIS_instructions2 - QGIS Abb. 18
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Gib dem virtuellen Raster bei Bedarf einen anderen Namen, indem du mit der rechten
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Maustaste darauf klickst und Layer umbenennen wahlst. Layernamen kannst du auBerdem

auch per Doppelklick auf den Layer iiber die Layereigenschaften unter Quelle dndern.

» Layereigenschaften - Virtuell | Quelle Abb. 19
- LayemamelS2A_L2A_T33UUV_20190?26_\rir1uell Ianzeigtals S2A L2A T33U0UV 20190726 Virtuel
q Information Quellkoordinatensystem setzen
| EPSG:32633 - WGS 84 / UTM zone 33N
Symbolisieren eines Mehrkanalrasters in Echt- oder Falschfarben
In den Layereigenschaften miissen die verschiedenen Bdnder innerhalb des virtuellen
Layers den RGB-Farbkandlen zugeordnet werden, um Bandkombinationen zu erstellen.
Doppelklicke dazu auf den virtuellen Layer im Layer-Bedienfeld oder gehe iiber die rechte
Maustaste auf Eigenschaften > Symbolisierung. Fiir ein Echtfarbenbild (True Color Image,
TCI) wahlst du unter Roter Kanal Band 4 aus, das im roten Spektralbereich liegt (hier
durch die Art des Bandimports als kanal 3 bezeichnet), unter Griiner Kanal Band 3 aus
dem griinen Spektralbereich (hier kKanal 2) und unter Blauer Kanal das Band 2 aus dem
blauen Spektralbereich (hier kanal 1).
» Layereigenschaften - Virtuell | Symbolisierung Abb. 20
———
q Information Darstellungsart|Mulﬁkanalfarbe =
;L;} Cuelle Roter Kanal IKanaIS vI
oE [l |
Griiner Kanal IKanaIZ 'I
Iﬂ Transparenz
o Min 581 | Max |1963 |
'n Histogramm Blauer Kanal | Kanal 1 'I
&, ‘ Darstellung Min |33? | Max |1988 |
P ‘S"Q Layer Einstellungen Erweiterungen Vektor Raster Datenbank Web Netz SCP Verarbeitung Hilfe Abb, 21
NEERRY (LRI PRLALBLOLRS &6 -K-&-0, > =9 - 77
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Fiir ein Falschfarben-Infrarotbild (Colored Infrared, CIR) legst du Band 8 aus dem Nahen
Infrarotbereich (hier Kanal 4) in den Roten Farbkanal, Band 4 aus dem griinen
Spektralbereich (hier kanal 3) in den Griinen Farbkanal und griine Band 3 (hier Kanal 2)

fiir den blauen Kanal aus. Auch andere Bandkombinationen sind moglich.

Layereigenschaften - Virtuell | Symbolisierung

Abb. 22
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Was ist ein Index und wie wird er berechnet?

Anhand unterschiedlicher Reflexionseigenschaften von Objekten konnen mit
Satellitendaten Aussagen z.B. iiber die Biomasse, Vitalitdit und Art von Vegetation
getroffen werden. Uber simple Bandkombinationen hinaus kann man zu diesem Zweck
auch sog. Indizes nutzen, die gezielt bestimmte Merkmale der Erdoberflache
hervorheben und auch quantitative Aussagen ermoglichen. Ein Index stellt
gewissermafien einen kiinstlichen Kanal dar, der als lineare Kombination oder Bruch
(Ratio) verschiedener Bander berechnet wird.

Es existieren eine Vielzahl von Indizes. Der wohl bekannteste ist der ,Normierte /
Normalisierte Differenzierte Vegetationsindex*“ (Normalized Difference Vegetation Index,
kurz NDVI) 4. Der NDVI gibt Aufschluss iiber die Vitalitdit der Vegetation
(Chlorophyllgehalt), denn Vegetation unter (Trocken-)Stress reflektiert einerseits starker
im roten Bereich, andererseits weniger stark im Nahen Infrarot (NIR). Die Werte des NDVI
reichen von -1 bis +1. Zur Berechnung des NDVI werden die Werte des NIR-Kanals (Band
8) und des Rot-Kanals (Band 4) herangezogen. Er wird wie folgt berechnet:
nir —rot

NDV] = ———
nir + rot

Benutzen des Rasterkalkulators

Mit dem Rasterkalkulator lassen sich in QGIS eingeladene Rasterdaten neu berechnen
oder auch miteinander verrechnen. Das ist nitzlich, wenn man aus Satellitendaten
Vegetationsindizes wie den NDVI berechnen mdéchte, denn dafiir werden Informationen
aus verschiedenen Bdndern bendtigt. Du findest den Rasterkalkulator in den QGIS-
Verarbeitungswerkzeugen unter Rasteranalyse > Raster calculator oder durch die
Benutzung der Suchleiste. Falls der Werkzeugkasten nicht angezeigt wird, aktiviere ihn

im Menii unter Ansicht > Bedienfelder > Verarbeitungswerkzeuge oder iiber das zahnrad-

Symbol.
eitung Hilfe = = 2 Abb. 24
& o -5-a-5 0 il =0 m-

== Qag @

@

» @ Interpolation
» @ Kartographie
» ( Layerwerkzeuge
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Berechnen eines Index per vordefinierter Formel am Beispiel NDVI

Im Rasterkalkulator von QGIS ist die Formel fiir den NDVI bereits unter Vordefinierte
Ausdriicke gespeichert, so dass du unter Hinzufiigen nur noch die beiden bendétigten
Bander auswdhlen musst. Wahle Band _Be8_ fiir NIR und Band _Bo4_ fiir Red. Klicke auf oK.
Daraufhin siehst du im Feld Ausdruck die vordefinierte NDVI-Formel mit den automatisch
hinzugefiigten Bandern. Lege anschlieBend unter Reference layer(s) > ... einen

Bezugslayer fest, iiber den du Pixelgrofe, Ausdehnung und KBS der Ausgabedatei
bestimmst. Im einfachsten Fall ware das einer der Eingabelayer, also Band 4 oder 8.
Du hast aber auch die Moglichkeit, diese Parameter unter cell size (Pixelgrofle), output

extent (Ziel-Ausdehnung) und output CRS (Ziel-KBS) ohne einen Referenzlayer separat

festzulegen.

Unter output legst du Name, Dateiformat und Speicherort deines spdteren Ergebnisses

fest. Lasst du das Feld leer, wird ein tempordrer Layer angelegt, der beim ndchsten
Programmstart nicht mehr verfiigbar ist. Gibst du hier lediglich einen Namen ein, wird der
Layer tief verborgen in der QGIS-Programmstruktur abgelegt und ldasst sich schwer
wiederfinden. Klickst duauf ... > In Datei speichern... kannst du das Ausgaberaster in

beliebigem Format dauerhaft abspeichern.

Setze abschlielend ein Hdkchen bei Offne Ausgabedatei nach erfolgreicher
Ausfiihrung und klicke auf Starte.

Q Raster calculator > Abb
. 25
Parameter Protokoll !
Expression
Layer Operatoren
T33UUV_20190726T102031_BC2_10m@1 e | + | = I cos | sin | bgw || anD

T33UUV_20190726T102031_B03_10m@1 |

T33UUV_20190726T102031_BO4_10m@1 | J

T33UUV_20190726T102031_B0Z_10m@1

T23UUV_20190726,_virtuel| @1 \ = [| sat || @ || amn | ( 1 ) J
\ |

T33UUV_20190726_virtuell@2
TN 20190T2A wirtuellm3

Ausdruck

(T330UV_20190725T 102031 BOS_10m@1 - T33UUV_20190726T102031 BO4_10m@1) / (T33UUV_20190726T102031 BOS_10m@1 + T33UUV_20190726T102031_BO4_10m@1)

Vordefinierte Ausdriicke

NDVI = l Hinzufiigen... 'l Speichern ‘

= Vordefinierte Formel

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

|D Elemente ausgewshlt Variablen

Cell size {use 0 or empty to set it automatically) [optional] NIR
| 8,000000 | T33UUV_20190726T 1020 mgt v a 3
Qutput extent {xmin, xmax, ymin, ymax) [optional] Red
| [Freilassen, um min. Abdeckungsausdehnung zu nutzen] ‘TSSJUV 20].9072&'1020." BO4_Ilm@1 - ‘ ||

Qutput CRS [optional]
| ik

e

|[1n tempor&rer Datei speichern]

V| Offne Ausgabedatei nach erfolgreicher Ausfithrung

[ 0% || Abbruch

| Als Batrhprozess starten ll Starte ' SchiieBen | | Hilfe |
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SchlieBe den Rasterkalkulator nach der Berechnung. Das Ergebnis ist ein neuer NDVI-
Layer (hier als output bezeichnet, da kein Name angegeben wurde), der im Layer-
Bedienfeld erscheint und in Graustufen dargestellt wird. Benenne den Layer am besten
so um, z.B. NDVI. Das erleichtert die Organisation, besonders bei vielen Layern im Projekt.

Abb. 26
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» [V W OSM Standard
X > . s o g
© MRS . B LY
; ¢
m*'z \ ¢ ‘
e 3 =0 o Y Wi, it ’ ™y
Q 7u suchender Typ (Strg+K) Koordinate | 334037,5981953 | ¥ Mafistab | 1:45049 | v | @ VergroBerung| 100% 12| prehung [0,0° 3| |V Zeichnen @ gpsGi2se3z @
— —

Symbolisieren eines Einkanalrasters am Beispiel NDVI

Der NDVI-Layer soll nun farbig dargestellt werden, damit die unterschiedlichen NDVI-
Werte klarer zu erkennen sind. Offne dazu mit einem Doppelklick auf den Layer NDVI
dessen Layereigenschaften und dort den Reiter Symbolisierung. Der Rasterlayer NDVI

besitzt im Gegensatz zum Echt- oder Falschfarbenbild nur einen Farbkanal; er ist ein
Einkanalraster. Stelle unter barstellungsart Einkanalpseudofarbe ein und wahle einen

passenden Farbverlauf, z.B. von Rot {iber Gelb zu Griin (RdY1Gn).

Um die farblichen Unterschiede fiir einen bestimmten Ausschnitt deutlicher
hervorzuheben, kannst du unter Min/Max-Werteinstellungen die Statistikausdehnung

auf Aktueller Ausschnitt begrenzen. Dadurch werden nur Werte beriicksichtigt, die sich
im aktuellen Ausschnitt befinden. Empfehlenswert ist auBerdem die Umstellung des
Modus auf Quantile. Damit erreichst du, dass die Klassifizierung, also die Einteilung der
Werte in verschiedene Gruppen, gleichmaBiger wird, weil so jeder Klasse gleich viele
Werte zugeordnet werden.

Die Verteilung der Pixelwerte eines Rasterlayers kannst du im Histogramm unter
Layereigenschaften » Histogramm einsehen.




SATELLITENDATEN VISUALISIEREN UND ANALYSIEREN
— ERSTE SCHRITTE MIT QGIS
Du kannst auch eigene Wertegrenzen definieren. Doppelklicke dazu einfach in die wert-

Spalte der Klassifizierungstabelle und trage die gewiinschten Werte ein. Dasselbe gilt fiir
die Spalte Beschriftung. Auch die Anzahl der klassen kann individuell festgelegt werden.

QGIS verwendet nur die englische Dezimalschreibweise, also Punkt statt Komma!
Unter Farbdarstellung findest du weitere Optionen zu Bildeigenschaften wie

Mischmodus, Helligkeit, Kontrast etc., mit denen du die Darstellung des Layers
optimieren kannst. Setze die Genauigkeit auf Genau (langsamer), wenn du mit der

Darstellung zufrieden bist und schlief3e den Dialog mit ok.

Nutze Anwenden statt 0K, um den Dialog nicht jedes Mal schlieen zu miissen.

» Layereigenschaften - NDVI | Symbolisierung X Abb. 2 /
-
w Kanaldarstellung

'ri Infermation

IDarsbeIIungsart |Enkanalpseudofarbe - I

;..:F Quelle Kanal |Kana| 1 {Gray) M |

“/ S . Min |-0.237553 Max 0.927766 |
ymbaolisierung e

w Min/Max-Werteinstellungen
I,‘a Transparenz

() Benutzerdefiniert

sy isto T i

& . Darstellung

B Pyramiden Sétﬁ:ir;:gsfndard_ |2,00 |2

ah Metadaten Statistikausdehnung Aktueller Ausschnitt -

Genauigkeit Genau (langsamer) -
Legende

. i : .
" qais Server Interpolation | Linear |

Farbveract -_— -

Beschriftungs- | |
einheitssuffix

Wert Farbe Beschriftung

-0,23162274... . -0.231622740626335

0.209430507... 0.209430507299304

0.4942873238...

0.924970814... . 0.924970814958215

Werte auf Bereich beschranken

p Farbdarstellung

P Abtastung =

Stil = I oK I| Abbrechen |I Anwenden I| Hilfe |

22
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Speichere Stil... Lade Stil...

Im Kartenfenster werden nun negative Werte in rot (im Fall des NDVI meist
Wasserflachen), positive niedrige Werte in orange (geringe Vitalitat) bis hohe Werte nahe
1 (vitale Vegetation) in dunkelgriin dargestellt.

Abb. 28

Projekt iten  Ansicht Layer Einstellungen Erweiterungen Vektor Raster Datenbank Web Netz SCP Verarbeitung Hilfe

o os 0 ~ & B G v o = .
DoBRRE LRI PRRALBENR &0 K- G EMI=- T
MOV/AMB 7/ B%/x @B <0 Hbo =4 RS % %%%s &\

Browser T T - 1 % Verarbeitungswerkzeuge
TRY®O %208 &N
sl Q suche.
5 en » (U Karzlich verwendet
v [¥ Projektverzeichnis » @ Dateiwerkzeuge
» Home i @ Datenbank
» OB » @ Grafik
» O » @ Interpolation
@ GeoPackage » @ Kartographie
/£ SpatiaLite » @ Layerwerkzeuge
@ rosiais » @ Netzwerkanalyse
P mssaL | » @ Rasteranalyse
@ Oracle » @ Rastergelandeanalyse
& ps2 » @ Rasterwerkzeuge
» @ wMSWMTS » @ Vektoranalyse
» B XYZTiles | R £ » @ Vektorauswahl
R » @ Vektoren allgemein
@®
Layer e® . » @ Vektorerzeugung
s @O T -RBAOL » @ Vektorgeometrie
B vl » @ Vektorlayeriberlagerung
W -0.231622740626335 » Q) Yerotsbelie
17 0.209480507299304 » . EnMAP-Box
0.494287328794599 * @ GDAL
17 0.791829414665699 > @ GRASS
[ 0.924970814958215 » & saca
[[] B T33UUV._20190726_virtuell
» [ B T33UUV_20190726T102031_B08_10m
» [ B T33UUV_20190726T102031_B04_10m
» [ @ T33UUV.20190726T102031_B03_10m
» [ W T33UUV._20190726T102031_B02_10m
» [V ¥ OSM Standard
[ Q" 2u suchender Typ (strg 0 5 : | 100% %/ Drehung [0,0° 3| |V zeichnen @ EPse:32633 @
S — — —

Berechnen eines Index per manueller Eingabe am Beispiel NDWI

In QGIS konnen auch eigene Indexberechnungen und Bandberechnungen im Allgemeinen
mit dem Rasterkalkulator durchgefiihrt werden. Als Beispiel wollen wir hier den
,Normalisierten Differenzierten Wasser-Index“ NOW/ nach Gao * berechnen. Der Index
eignet sich, um Unterschiede im Wassergehalt der Blatter darzustellen. Er wird hdufig zur
Uberwachung von Wasserstress in der Vegetation verwendet. Zur Berechnung werden die
Badnder Nahes Infrarot (Band 8) und Kurzwelliges Infrarot (Band 11) benutzt:

nir — swir
nir + swir
Lade Band 11 (nur in 20m Auflosung verfiigbar) als zusatzlichen Layer in dein GIS-Projekt
(vel. S.11, Importieren einer Sentinel-2-Szene). Offne den Rasterkalkulator in den

Verarbeitungswerkzeugen unter QGIS-Tools > Rasteranalyse > Raster calculator. Die

Formel fiir NDWI ist nicht vordefiniert. Kopiere daher den Ausdruck

(_B08_ - B11_) / (_BOS_ + _B11_ )
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in das Feld unter Ausdruck, markiere dann einen Platzhalter und doppelklicke auf das
entsprechende Sentinel-2-Band unter Layer. Alternativ kannst du die Formel auch Klick

fiir Klick {iber die operatoren eingeben.

Achte auf eine korrekte Syntax und die Leerzeichen vor und nach den Operatoren.

Lege unter Reference layer(s) ... einen Bezugslayer fest, um Pixelgrof3e, Ausdehnung

und KBS der Ausgabedatei festzulegen. Speichere bei Bedarf das Ausgaberaster iiber
Output ... > In Datei speichern..., setze abschlieend ein Hakchen bei 0ffne

Ausgabedatei nach erfolgreicher Ausfiihrung und klicke auf starte.

R Raster calculator x Abb. 29
Parameter | Protokoll ‘
Expression
Layer Operatoren
NDWIE1 [= ® ;
T33UUV_20190726T102031_B02_10m@1 ‘ | cos || sin || loglo | AND |
T33UUV_20190726T102031_B03_10m@1 _ - aos |[ asin || W || OR
T33UUV_20190726T102031_B08_10m@1
T23UUV_20190726T102031_B11_20m@1 o~ sat || ten || aten |
e
TI3UUV_20180726_virtuell@1 = < J = |l = Il = || = || ==
Ausdruck
("T33UUV_20190726T102031_B08_10m@1" - "T33UUV_20190726T102031_B11_20m@1") /
("T33UUV_20190726T102031_B08_10m@1" + "T33UUV_20190726T102031_B11_20m@1")
Vordefinierte Ausdriicke
|NDVI ~ | Hinzufiigen...| | Speichern...|
Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]
|0 Elemente ausgewshlt E
Cell size (use 0 or empty to set it automatically) [optional] il
0OSM Standard [EPSG:3857] 5 B
|0,000000 O5H Sandard 7S | Alle wahlen m 2|
i i i T33UUV_20100726T102031_B02_10m [EPS
Output extent (xmin, xmax, ymin, ymax) [optional] L A ma,m:\ L Auswahl aufheben
UUV_20190726T102031_BOS_10m [EPS
Output CRS [optional] 3UUV_20190726T102031_B11_20m [EPS

NDVI [EPSG:23833] | Datei(en) hinzufiigen...
| TI3UUV_20190726,irtuell [EPSG:32633]

|Verzeichnis hinzufiigen...

OQutput
|[In temporédrer Datei speichern] I oK

|
i | -
|[Freilassen, um min. Abdeckungsausdehnung zu nutzen] UUV_EOW%?EET‘IOEOEEBMJOm [EPS " Auswahl umschalten | |-
|
|
|

m'fvﬁne Ausgabedatei nach erfolgreicher Ausfiihrung 1 v | Abbrechen

| 0% || Abbruch
|Als Batchprozess starten. . || Hilfe |

Nach der Berechnung kannst du den Rasterkalkulator schlieBen, den neuen Layer in NDWI

umbenennen und ihn farbig symbolisieren. Stelle unter Darstellungsart
Einkanalpseudofarbe ein, wdhle einen passenden Farbverlauf, z.B. von Hell- nach

Dunkelblau (Blues), und spiele mit den Symbolisierungsoptionen, um die Unterschiede
besser hervorzuheben (vgl. S.21, Symbolisieren eines Einkanalrasters am Beispiel NDV)).




SATELLITENDATEN VISUALISIEREN UND ANALYSIEREN
— ERSTE SCHRITTE MIT QGIS

Niedrige Werte (Bereiche mit geringem Blattwassergehalt wie z.B. auf abgeernteten
Ackerflachen) sind nun hellblau dargestellt. Hohe NDWI-Werte, also Bereiche mit hohem
Blattwassergehalt, z.B. in der Flussaue, sind dunkel eingefarbt.

Projekt Bearbeiten Ansicht Layer Einstellingen Enweiterungen Vektor Rester Datenbank Web Netz SCP Verarbeitung Hilfe
[ ~
=0~ J ORI PRRALGBLERS &
BG4 W
Browser B® ‘ | Verarbeitungswerkzeuge (]3]
ORY®*O a2 3
¢ Favoriten | & suche...
» " Raumliche Lesezeichen =
B8 Prjevensieis N fromen s |
: ES ::"'e ~ @ Rasteranalyse
1 # Bericht eindeutiger Rasterwerte
@® GesPack % Nach Layer neuklassifizieren
,’ s‘:h::.ﬁ:ge # Nach Tabelle neuklassifizieren
@ roscs ## Raster calculator
» mssaL % Raster-Bool'sches ODER
® e 4% Raster-Bool'sches UND
i ¥ Rasterlayerstatistik
- @ WMS/WMTS i # Rasterlayerzonenstatistik -
» < ALKISBB Abfrageergebnisse B
Layer B8 ’ o ; - B RS 58 »
v BeTo-BAO Objekt Wert
v v NOWI ol
-0.817927181720734
-0.14239316034317
1 0.026196634769439
325021793842316
[ 0.226260917663574
~ W # NDVI
[ -0231622740626335
171 0.209480507299304
0.494287326794599
[ 0.791820414665699
[ 0.524970814958215
] B T33UUV_20190726_virtuell
» [] B T33UUV_20190726T102031_B11_20m “ | Modus | Layerauswahl -
» [] B T33UUV_20190726T102031_B08_10m =
» [] W T33UUV_20190726T102031_804_10m o = vl : ﬂ 'a, Ansicht |Baum  ~ | Hilfe ‘
» (| S8 7330001V 20190726T102031 RO 10m. s ¥y ik A . S _  SELRNF, £ ——
| @ Zu suchender Typ (Strg+K) 1 Eintrag Koordinate | 384629,5977380 ‘%’ MaBstab | 1:45387 " & VergroBerung 100% | Drehung 0,0 ° 2| v/ Zeichnen @ EPSG:25833 @
T —————— ————
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Exkurs Vektordaten und offene Geodaten

Vektordaten kann man selbst erstellen, z.B. aus Rasterdaten iiber das GRASS-Werkzeug
r.to.vect oder durch das Abdigitalisieren einer Karte iiber die Editierfunktion im GIS.
Man kann sie auch kaufen und sogar als offene Geodaten kostenlos herunterladen oder
liber einen Web Feature Service beziehen. Inzwischen gibt es im Internet eine Vielzahl frei
verfiigharer Geodaten von hervorragender Qualitdt. Immer mehr Bundeslander stellen
offene Daten der Landesdamter fiir Vermessungswesen oder Geoinformation (iber
Geodatenportale zur Verfiigung; entweder als direkte Dateidownloads oder sogenannte
Webdienste, die dann in eigene GIS-Systeme oder Anwendungen integriert werden

konnen. In der folgenden Tabelle sind einige Beispiele aufgelistet.

Bundesland Portal Urheber
Baden- LGL LGL Landesamt fiir Geoinformation
Wiirttemberg  https://www.lgl-bw.de/Produkte/Open-Data/ und Landentwicklung
Bayern  OpenData Portal der Bayerischen Staatsregierung Landesamt fiir Digitalisierung,
https://www.ldbv.bayern.de/produkte/weitere/opendata.html Breitband und Vermessung
Berlin  FIS-Broker Senatsverwaltung fiir Stadt-
https://fbinter.stadt-berlin.de/fb/ entwicklung, Bauen und Wohnen
Brandenburg  GEOBROKER LGB Landesvermessung und
https://geobroker.geobasis-bb.de/ Geobasisinformation Brandenburg
Hessen Geodaten Online Hessische Verwaltung fiir Boden-
https://gds.hessen.de management und Geoinformation
Mecklenburg-  Geoportal MV Land(isamt furlnner(:: Verwaltung MV,
v h . l d 0 Amt fiir Geoinformation, Vermessungs-
orpommern ttps://www.geoportal-mv.de/portal/ und Ratateritisah

Niedersachsen

Nordrhein-
Westfalen

Rheinland-Pfalz

Sachsen

Sachsen-Anhalt

OpenGeoData.NI
https://opengeodata.lgln.niedersachsen.de/

Geobasis NRW
https://bezreg-koeln.nrw.de/
brk_internet/geobasis/opendata/index.html

Open Data - Freie Daten und Dienste der Vermessungs- und
Katasterverwaltung Rheinland-Pfalz
https://lvermgeo.rlp.de/de/geodaten-geoshop/opendata/

Offene Geodaten
https://www.geodaten.sachsen.de/

Dienste & Download
https://www.lvermgeo.sachsen-anhalt.de/de/
dienste__download.html

LGLN Landesamt fiir Geoinformation
und Landesvermessung Niedersachsen

Bezirksregierung Kéln

Landesamt fiir Vermessung und
Geobasisinformation

Staatsbetrieb Geobasisinformation und
Vermessung Sachsen GeoSN

Landesamt fiir Vermessung und
Geoinformation Sachsen-Anhalt

Thiiringen  Geoportal-TH Landesamt fiir Bodenmanagement und
https://www.geoportal-th.de/de-de/Downloadbereiche/Download-  Geoinformation
Offene-Geodaten-Thiiringen

Bundesweit Open Data des BKG Bundesamt fiir Kartographie und
https://gdz.bkg.bund.de/index.php/default/open-data.html Geoddsie

Eine sehr gute Ubersicht bietet auch OpenGeoEdu auf der Seite

https://learn.opengeoedu.de/opendata/vorlesung/offene-geodaten/amtliche-

geodaten und dem OpenDataPortal https://portal.opengeoedu.de/.



https://www.lgl-bw.de/Produkte/Open-Data/
https://www.ldbv.bayern.de/produkte/weitere/opendata.html
https://fbinter.stadt-berlin.de/fb/
https://geobroker.geobasis-bb.de/
https://gds.hessen.de/
https://www.geoportal-mv.de/portal/
https://opengeodata.lgln.niedersachsen.de/
https://bezreg-koeln.nrw.de/brk_internet/geobasis/opendata/index.html
https://bezreg-koeln.nrw.de/brk_internet/geobasis/opendata/index.html
https://lvermgeo.rlp.de/de/geodaten-geoshop/opendata/
https://www.geodaten.sachsen.de/
https://www.lvermgeo.sachsen-anhalt.de/de/dienste__download.html
https://www.lvermgeo.sachsen-anhalt.de/de/dienste__download.html
https://www.geoportal-th.de/de-de/Downloadbereiche/Download-Offene-Geodaten-Thüringen
https://www.geoportal-th.de/de-de/Downloadbereiche/Download-Offene-Geodaten-Thüringen
https://gdz.bkg.bund.de/index.php/default/open-data.html
https://learn.opengeoedu.de/opendata/vorlesung/offene-geodaten/amtliche-geodaten
https://learn.opengeoedu.de/opendata/vorlesung/offene-geodaten/amtliche-geodaten
https://portal.opengeoedu.de/
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Einladen bereits vorhandener Vektordaten

Die einfachste Variante ist das sogenannte Drag & Drop. Du kannst vom Speicherordner

deiner Dateien aus die gewiinschte(n) Vektordatei(en) einfach markieren, bei gehaltener
linker Maustaste ins QGIS-Fenster ziehen und dort loslassen.

Abb. 31
sampleMaterial
Start Freigeben Ansicht
v P <« 3_Datenanalyse_Datenexport_GIS > QGIS > sampleMaterial
Name B Anderungsdatum Typ
__ Schlaggrenzen.cpg 30.10.2020 14:45 CPG-Datei
' Schlaggrenzen.dbf 30.10.2020 14:45 OpenOffice.org 1....
__| Schlaggrenzen.prj 30.10.2020 14:45 PRJ-Datei
__ Schlaggrenzen.shp 30.10.2020 14:45 SHP-Datei
__| Schlaggrenzen.shx 30.10.2020 14:45 SHX-Datei
27Elemente 5 Elemente ausgewahlt (18,2KB)  Status: @ Online
" - . N TN
Alternativ kannst du auch im QGIS-Menii iiber Layer > Layer hinzufiigen > Vektorlayer
hinzufiigen deinen Layer einladen. Wahle Datei als Quelltyp. Klicke auf ... und navigiere
zum Speicherort deiner Vektordatei.
Datenquellenverwaltung | Vektor X Abb. 32
ri Browser Qu elltyp
‘e Datei | Verzeichnis ' Datenbank ' Protokoll: HTTP(S), Cloud, etc.
+ Raster T—
. Kodierung |UTF-8 -
A% Netz
+*
Getrennte Texte Quelle
Vektordatensatze batenexport_GIS\QGIS\sampIeMaterial\SchIaggrenzen.shp a |E
* PostgreSQL | Hilfe |
Zur besseren Auffindbarkeit wahle das gesuchte bateiformat aus, dann deine batei und
bestatige die Auswahl mit 6ffnen. Anschlieflend klickst du auf Hinzufiigen und SchlieRen.
Organisieren v Meuer Ordner =z ~ [N 0 Abb. 33
A Name - Anderungsdatum Typ GroBe ~
T33UUT_20190726_SACP 13.01.2020 16:38 Dateiordner
T33UUU_20190726 25.10.2019 15:21 Dateiordner
D Demmin_5chlage_aus_Feldblockkataster...,  29.10.2020 12:29 SHP-Datei 27 KB

30.10.2020 14:33
30.10.2020 14:45

SHP-Datei
SHP-Datei

| | FeldbléckeMV Auswahl Demmin.shp
D Schlaggrenzen.shp

Dateiname: | Schlaggrenzen.shp ~ |

Abbrechen
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Gewinnen von Vektordaten aus einem Web Feature Service (WFS)

Ein Web Feature Service ist ein Webdienst, der georeferenzierte Vektordaten bestehend
aus so genannten ,Features“ ausgibt und sich in ein GIS oder webbasierte
Kartenanwendungen einbinden ldsst.

Fiir dieses Beispiel verwenden wir einen kostenfreien WFS des Geoportals MV. Um an die
URL dieses Dienstes zu kommen, offne die Webseite https://www.geoportal-
mv.de/portal/Geowebdienste/Fachthemen/Landwirtschaft und_Forst und erweitere die
Ansicht fiir Feldblockkataster MV WFS > einblenden. Die URL findest du am Ende des

Abschnitts. Markiere die URL und kopiere sie mit STRG+C in den Zwischenspeicher.

Auch andere Bundesldnder bieten Feldblockkataster als WFS an. Hier ein Link zum
Geobroker fiir Brandenburg.

ﬁ Suche Geodatenviewer Geowebdienste Geofachanwendungen Geodatenshop Mein GeoPortal.MV Ab b .34

> Fachthemen Landwirtschaft und Forst

> Alle Fachthemen
> Topographische Karten

> Luftbilder und Satellitenbilder feldblocka ey ertenden
> Hohe und Gelédnde I Feldblockkataster MV WFS ausblenden I
> Verwaltungseinheiten
> Bildung und Soziales Beschreibung/Anbieter:
> Geologie, Rohstoffe und Bergbau »Beschreibung
> Landwirtschaft und Forst Ministerium fiir Landwirtschaft und Umwelt M-Y
> Liegenschaftskataster und Wi
Grundstiickswerte

Nutzungsbedingungen: Die Giber Geowebdienste visualisierten Geodaten sind durch das das Urheberrechtsgesetz (UrhG) in den jeweils
geltenden Fassungen gesetzlich geschitzt. Zuwiderhandlungen gegen die gesetzlichen Schutzregelungen sind mit BuBgeld oder Strafe
> Umwelt und Naturschutz bedroht. Eine Wiederveroffentlichung ist nur mit zustimmung des Ministerium fur Landwirtschaft und Umwelt M-V, Paulshoher Weg 1,
19061 Schwerin erlaubt.

> Tourismus und Freizeit

> Verkehr

> Energie INSPIRE identifiziert: ja

> Wasser Status des Dienstes:

> Wirtschaft und Planung ]

> Sonstiges -

5 URL des Dienstes (WFS):
> INSPIRE-Themen . . .
https://www.geodaten-mv.de/dienste/gdimv_feldblock wfsa

> Katalogdienst

> Hinweise zu Geowebdiensten
> Statistik MV Windenergie WMS einblenden

MV Landwirtschaft WMS einblenden

Jetzt sollen die Daten als WFS-Layer in QGIS hinzugefiigt werden. Wahle dazu im QGIS-
Menii Layer > Layer hinzufiigen > WFS-Layer hinzufiigen und lege eine neue WFS-

Verbindung an. Klicke dazu auf Neu. Fiige die kopierte Adresse des Webdienstes in das
Feld URL und eine Bezeichnung fiir die neue Verbindung in das Feld Name ein. Bestadtige
mit OK.



https://www.geoportal-mv.de/portal/Geowebdienste/Fachthemen/Landwirtschaft_und_Forst
https://www.geoportal-mv.de/portal/Geowebdienste/Fachthemen/Landwirtschaft_und_Forst
https://geobroker.geobasis-bb.de/gbss.php?MODE=GetProductInformation&PRODUCTID=9e95f21f-4ecf-4682-9a44-e5f7609f6fa0
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» Datenquellenverwaltung | WFS X
Abb. 35

[ Browser
Y .', Vektor

Serververbindungen

Raster \Geoportal MV Feldblockkataster -]
* s

B Netz \yerbindenl Neu IBearbeiten||Entfernen| | Laden | Speichern

4 Getrennte Texte ‘

$# GeoPackag ' » Neue WFS-Verbindung anlegen
74 Spatialite

e Verbindungsdetails

*ZZSCEL Name | Geoportal MV Feldblockkataster I
=8 De2 URL | https://www.geodaten-mv.de/dienste/gdimv_feldblock_wfs |
m irtueller L|
& Vw;q ,Wh: Authentifizierung

Konfigurationen ‘ Basic

Authentifikationskonfiguration wahlen oder anlegen
Keine Authentifikation - £ E

Klicke dann auf Verbinden. Die verfiigbaren WFS-Layer erscheinen daraufhin in der Liste.
Wadhle Feldblockkataster MV - Feldblécke aus und aktiviere das Hakchen Titel als

Layernamen verwenden. Klicke zum Schluss auf Hinzufiigen und SchlieRen.

» Datenquellenverwaltung | WFS s Abb. 36
Serververbindungen
| Ve | Geoportal MV Feldblockkataster -
 Raster Verbinden|| Neu | Bearbeiten | Entfernen| | Laden | Speichern |
_‘!:_ Metz §
Filter | |
g Getrennte Tedte Title ~ Name Abstract Sl

Feldblockkataster MV - Nichtbeihilfefdhige Flichen  mwinbf_flaechen

l Feldblockkataster MV - Feldblacke mv:feldbloecke | |

‘{d GeoPackage

 Oracle 1 v
082, oe itel als Layernamen verwenden
v/ Nur Objekte laden, die sich mit dem Kartenausschnitt (iberschneiden
Koordinatenbezugssystem
EPSG:25833 | Andem... |

| Abfrage erstellen |I SchlieBen I|ﬂinzufiiged| Hilfe |

Der WFS-Layer erscheint nun in deinem QGIS-Hauptfenster. Um aus diesem Layer nur die
relevanten Features fiir die Weiterverarbeitung herauszufiltern, markiere ein oder
mehrere Feldbldocke und speichere sie in einem separaten Shapefile. Aktiviere dazu die
Funktion Objekte iiber Rechteck oder Einzelklick wdhlen aus der Werkzeugleiste und

klicke das gewiinschte Feature an. Der entsprechende Layer muss dafiir markiert sein.

Mehrere Features gleichzeitig aktivierst du durch mehrmaliges Klicken bei gehaltener
Shift-Taste. Speichere deine Auswahl mit Rechtsklick auf den Layer Feldblockkataster

MV - Feldblécke > Exportieren > Gewdhlte Objekte speichern als.. und wadhle
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Speicherformat und Speicherort {iber . ... Achte darauf, dass das Hakchen gesetzt ist bei

Gespeicherte Datei zur Karte hinzufiigen und bestdtige mit oK.

*QGIS_instructions2 - QGIS

Projekt Bearbeiten Ansicht Layer Einstellungen Erweiterungen Vektor Raster Datenbank Web Netz Hilfe
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Abdigitalisieren vom Raster- zum Vektorlayer

Du kannst eigene Vektordaten in QGIS erstellen, indem du z.B. die Schlaggrenzen aus
einem aktuellen Satellitenbild in einem leeren Vektorlayer nachzeichnest. Gehe dazu
iber das Menii zu Layer > Layer erstellen > Neuer Shape-Datei-Layer....

» Meuer Shapedatei-Layer Abb. 38

Dateiname |tenanaIyse_Datenexport_GIS\QGIS\sampleMateriaI\Mein eigener Vektorlayer.shp & |E

Dateikodierung UTF-8 - |
Geometrietyp I = Polygon > I
Zusdtzliche Dimensionen ® Keine ) Z (+ M-Werte) ) M-Werte

\EPSG:4326 - WGS 84 -] (@

Neues Feld

Name | SchlagNr
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Lange(80 | Genauigkeit
I Zur Feldliste hinzufiigen I
Feldliste
Name Tvp Lénge Genauigkeit
id Integer 10
Schlaghr String 20
Feld loschen

| Abbrechen | | Hilfe
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Weise dem neuen Layer {iber ... einen Dateinamen und Speicherort zu und lege als
Geometrietyp Polygon fest. Falls du deinen aufgenommenen Daten weitere Attribute
mitgeben mochtest, z.B. Schlagnummer oder Kulturart, definiere unter Neues Feld
entsprechende Parameter und klicke auf Zur Feldliste hinzufiigen. Klicke abschlieBend
OK.

Attributtabelle o6ffnen

Um im neu angelegten Layer eigene Features erstellen zu kdnnen, aktivierst du den
Bearbeitungsmodus mit Klick auf das gelbe Stift-Symbol in der Werkzeugleiste und
anschlieend auf das Symbol Polygonobjekt hinzufiigen. Mit dem Fadenkreuz-Mauszeiger
kannst du nun Klick fiir Klick ein Polygon aufziehen und dich dabei an der Grundkarte
orientieren. Du schlieit das Polygon mit einem Klick mit der rechten Maustaste. Gib
anschlieBend die Attribute an und bestdtige mit oK. Solange der Bearbeitungsmodus

aktiviert ist, kannst du weitere Polygone erstellen oder l6schen. Um ein Objekt zu
l6schen, aktivierst du das Werkzeug Objekte iiber Rechteck oder Einzelklick wéhlen,
markierst dann das Feature und driickst die Entf-Taste. Nachdem du die Features
fertiggestellt hast, speichest du die Anderungen deines Vektorlayers mit Klick auf das
rote Stift-Symbol > Speichern gewdhlter Layer und beendest den Bearbeitungsmodus
durch erneuten Klick auf das gelbe Stift-Symbol.

Abb. 39

Projekt Bearbeiten ht Layer Einstellingen Enweiterungen Vekior Rester Dafenbank Web Netz Hilfe

DepEnRY Qe oNPDPH Q0 BEOS Q@-Bh-5,58E X -6 [0
LINIAY ] ] [ EEREE \qg"@:%%% Qa® -~ H

Browser Pt £ . 4

/7 Favoriten

» (¥ Projektverzeichnis

/] H
B schtaggrenzen " Schlag Nr. |01 a
W FeidbisckeMV Auswahl Demmin i

W Feidblockiataster MV - Feldblacke /|
Ed

~ NDWI A . )

1] 0.791220414665699
W 0s24070214958215
] W 7330UV_20190726_virtuell Wy
b ] W T33UUV_20190726T102031_B11_20m L Fapu
b [[] M T23UUV_20190726T102031_BO8 10m 'ﬁ
» [ B T3300V_20190726T102031_BO4 10m

e : a Far )
Q Zu suchender Typ (Strg+K) Koordinate| 375548,5078064 | % Mabistab 1:13795 ﬂ & VergroBerung| 100% | Drehung
e EEEE——




SATELLITENDATEN VISUALISIEREN UND ANALYSIEREN
— ERSTE SCHRITTE MIT QGIS

Reprojizieren von Vektordaten

Wie bereits erwdhnt, ist es fiir genaue Prozessierungen wichtig, dass die beteiligten Layer
dasselbe Koordinatenbezugssystem besitzen (siehe S.13, Anpassen  des
Koordinatenbezugssystems). Passe dazu das KBS des Vektorlayers an und benutze dazu
das Werkzeug Layer reprojizieren. Du kannst die Suchleiste nutzen, um ein

bestimmtes Werkzeug zu finden. Doppelklicke anschlieBend auf das entsprechende
Werkzeug.

Abb. 40

Projekt Bearbeiten Ansicht Layer Einstellungen Erweiterungen Vektor Raster Datenbank Web Netz SCP Verarbeitung Hilfe
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Wabhle als Eingabelayer deinen Vektorlayer aus, den du umprojizieren mochtest und als
ziel KBS das Koordinatenbezugssystem der Sentinel-2-Daten. Gib dann unter
Reprojiziert den Ausgabepfad und Dateityp an, indem du auf ... > In Datei
speichern. .. klickst. Halte deine Projektdateien {ibersichtlich und gib im Dateinamen die
Projektion an. Klicke dann auf starte und nachdem der Prozess abgeschlossen ist, auf

SchlieRen.

» Layer reprojizieren ¥ Abb. 41
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Wie schneide ich mein Satellitenbild auf einen Ausschnitt zu?

Nicht immer ist es notwendig, komplette Sentinel-2-Kacheln weiter zu verarbeiten, denn
oft sind es nur kleinere Gebietsausschnitte, die von Interesse sind. Um
Verarbeitungszeiten und Speicherlast gering zu halten, lohnt es sich, die
entsprechenden Flachen aus den Daten zu extrahieren. Besonders praktisch ist es, einen
Layer als Schablone zu benutzen und das Satellitenbild darauf zuzuschneiden. Hierzu
eignen sich Vektordaten in Polygonform, die das gewiinschte Gebiet genau definieren;
aber auch Rasterdaten kdnnen als Schnittmaske benutzt werden. Beispielhaft soll hier
das Raster per Polygon-Vektor auf einen landwirtschaftlichen Ackerschlag zugeschnitten
werden.

Zuschneiden auf ein Polygon

Wahle im Menii Raster » Extraktion > Raster auf Layermaske zuschneiden.

» Raster auf Layermaske zuschneiden x Abb. 42
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Der Eingabelayer ist das Raster, z.B. der berechnete NDVI. Der Maskenlayer ist z.B. der
vorher umprojizierte (Polygon-) Vektorlayer mit den Feldgrenzen. Gib unter Abgeschnitten
(Maske) > ... > In Datei speichern... wieder einen Ausgabepfad, Dateinamen und
Dateityp an, bestdtige mit Starte und klicke auf SchlieRen, wenn der Prozess beendet ist.

Die Satellitendaten sind nun auf den Ausschnitt der Polygonflache zugeschnitten.

Abb. 43

Projekt Bearbeiten Ansicht Layer Einstellungen Erweiterungen Vektor Raster Datenbank Web Netz SCP Verarbeitung Hilfe
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Wie exportiere ich die Daten als Bilddatei?

Fiir bestimmte Zwecke kann es hilfreich sein, Daten nach Bearbeitung aus dem GIS zu
exportieren, z.B. um sie fiir ein anderes Projekt oder eine Prasentation zu verwenden.
Dafiir stehen verschiedene Dateiformate zur Verfiigung. Uber das Format GeoTIFF kénnen
Daten verlustfrei und mit zusatzlicher Georeferenz heruntergeladen werden.

Um einen bestimmten Layer als GeoTIFF abzuspeichern, wahle nach Rechtsklick auf den
entsprechenden Layer die Option Exportieren > Speichern als. Setze den Ausgabemodus

auf wie dargestellt, wahle unter Format das gewiinschte aus und gib unter bateiname »

... den gewiinschten Speicherort und Dateinamen an. Setze ein Hikchen neben

Gespeicherte Datei zur Karte hinzufiigen, wenn du das Exportergebnis in QGIS

iberpriifen oder damit weiterarbeiten mochtest.

Rasterlayer speichern unter... X Abb. 44

Ausgabemodus |
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Wenn du nicht nur einen einzelnen Layer, sondern deine gesamte aktuelle
Zusammenstellung als Bild exportieren mochtest, ggf. in geringerer Auflosung oder ohne
Georeferenzierung, kannst du im Menii {iber Projekt > Import/Export > Karte als Bild
speichern deine Arbeit auch als JPG, PNG, etc. ausgeben lassen. Auch eine PDF-Option
findet sich dort.

Es Offnet sich dann ein neues Fenster, in dem du den Kartenausschnitt sowie weitere
Parameter festlegen kannst. Um die Kartenausdehnung zu definieren, musst du nicht
unbedingt die genauen Koordinaten eingeben. Du kannst einfach den aktuellen
Ausschnitt nehmen, den du gerade in deinem Kartenfester siehst. Klicke dazu auf die
Schaltfliche Kartenausschnittsausdehnung. Alternativ kannst du aber auch iiber das
Drop-Down-Menii Aus Layer berechnen die Ausdehnung eines anderen Layers
tibernehmen, der sich in deinem Projekt befindet.

Ebenso kannst du deinen Export {iber MaBstab, Ausgabebreite und Ausgabehéhe

definieren. Als Auflésung sind 300 dpi zu empfehlen. Ist der Export nur fiir die
Bildschirmansicht und nicht fiir den Druck, reichen auch 72 bis 150 dpi.

Uber das Hikchen neben Georeferenzierungsinformation anhingen (eingebettet oder
als World-Datei) kannst du steuern, ob dein Bild mit oder ohne Georeferenzierung
abgespeichert werden soll. Hat es eine Georeferenzierung, kann es in jedem anderen GIS

und GIS-Projekt wieder eingelesen und an die richtige Stelle projiziert werden. Klicke auf
Speichern.

Q QGIS_instructions2 — QGIS — ] X
Projekt Bearbeiten Ansicht Layer Eini G Karte als Bild speichern X fe Abb. 45
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Es 6ffnet sich der bekannte Speicherdialog, {iber welchen du Speicherort, Dateiname und

Dateityp festlegen kannst. Klicke dann wieder auf Speichern.

@ Dateiname zum Speichern des Kartenbilds wahlen X

« ~ N1 I Desktop * v IO 2 Desktop durchsuchen

oaepemer|

Dateityp: PNGformat(*png*PNG) .

~ Ordner durchsuchen Abbrechen

ﬂ

Nach dem Abspeichern sollte deine Bilddatei in dem von dir vorher festgelegten Ordner
und Dateiformat vorliegen. Hast du das entsprechende Hakchen vorher gesetzt und als
Dateiformat z.B. PNG ausgewadhlt, wird neben deiner PNG-Datei zusatzlich eine PGW-
Datei ausgegeben, die die Georeferenzierung enthalt. Solltest du diese nicht mehr
benoétigen, kannst du sie einfach l6schen, ohne dass dies negative Auswirkungen auf
deine PNG-Datei hat.
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Weiterfiihrende Online-Quellen

SAPIENS Modul 2: Satellitendaten visualisieren und analysieren — Basiswissen (Q)GIS
Teil 1 https://youtu.be/3h]h8YFxZfo
Teil 2 https://youtu.be/ziR2Ljirgow

FERN.Lern Webseite:
https://fernlern.gfz-potsdam.de/lernen

FERN.Lern Youtube-Kanal:
https://www.youtube.com/FernerkundunglLernen

QGIS Webseite
https://www.qggis.org/de/site/

QGIS Dokumentation
https://docs.qgis.org/3.16/de/docs/user_manual/

QGIS Grundlagen - Eine sanfte Einfiihrung
https://docs.qgis.org/3.16/de/docs/gentle _gis_introduction/

QGIS Trainingshandbuch
https://docs.qgis.org/3.16/de/docs/training_manual/

QGIS Anleitungen und Tipps
https://www.qgistutorials.com/de/

QGIS lernen — Eine GIS Lernplattform
https://www.gis-lernen.de/

Webdienste in QGIS nutzen
https://flf.julius-kuehn.de/webdienste/webdienste-nutzen.html

YouTube Kanal ,,Marshal Mappers*
https://www.youtube.com/channel/UCKwCohc)r-4mgsNUe)zMAvA/videos

YouTube Kanal ,,Skandigraph*
https://www.youtube.com/channel/UCnmpPEb19bBIcT]1QXu1k7Q/videos

YouTube Kanal ,,PyQGIS*
https://www.youtube.com/channel/UCOnU8rXypMv)Q-Zopl6mCgQ/videos
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Aufrufen der Systemeigenschaften des Computers im Windows Explorer. Quelle: Eigene Bildschirmkopie. =

Windows 10 Startmendi. Quelle: Eigene Bildschirmkopie. =

QGIS-Benutzeroberfldche (Version 3.16): Meniileiste und Werkzeugauswahl. Quelle: Eigene Bildschirmkopie. =*

QGIS-Benutzeroberfliche (Version 3.16): Projekteigenschaften, Erweiterungen verwalten und Verarbeitungswerkzeuge.
Quelle: Eigene Bildschirmkopie. =

QGIS-Benutzeroberfldche (Version 3.16): Browser- und Layerbedienfeld, Kartenansicht und Statusleiste. Quelle: Eigene
Bildschirmkopie. =

Neues leeres Projekt anlegen mit QGIS 3.16. Quelle: Eigene Bildschirmkopie. =
Erweiterung installieren mit QGIS 3.16 und der Erweiterung QuickMapServices. Quelle: Eigene Bildschirmkopie. -

Aufruf der OSM Standard-Basiskarte mit QGIS 3.16 und der Erweiterung QuickMapServices. Quelle: Eigene
Bildschirmkopie. © OpenStreetMap-Mitwirkende, https://www.openstreetmap.org =

Spektrale und raumliche Auflosung der 13 Bander von Sentinel-2. Quelle: A. Cozacu, GFZ. Eigene Darstellung nach Daten
der ESA. ESA Sentinel Online. Radiometric Resolutions of Sentinel-2-MSI. User Guides
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-2-msi/resolutions/radiometric (2020). £

Verzeichnisstruktur von Sentinel-2 Level 2A-Daten im Windows Explorer. Quelle: Eigene Bildschirmkopie.
© Copernicus Data 2019 =

Rasterlayer hinzufiigen mit QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Einladen einzelner Sentinel-2-Bdnder in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019
© OpenStreetMap-Mitwirkende, https://www.openstreetmap.org =

FuBmendiileiste in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =
Einstellen des Koordinatenbezugssystems in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =*

Sentinel-2-Szene im KBS WGS84 / UTM Zone 33N (EPSG:32633) mit QGIS 3.16. Quelle: Eigene Bildschirmkopie.
© Copernicus Data 2019 © OpenStreetMap-Mitwirkende, https://www.openstreetmap.org =

Generieren eines virtuellen Rasters in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Virtuelles Multikanalraster in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019 © OpenStreetMap-
Mitwirkende, https://www.openstreetmap.org =

Umbenennen eines Layers in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =
Symbolisieren eines Echtfarbenkomposits in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Echtfarben-Darstellung mit der Sentinel-2-Bandkombination 4-3-2 in QGIS 3.16. Quelle: Eigene Bildschirmkopie.
© Copernicus Data 2019 =

Symbolisieren eines Falschfarbenkomposits in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Falschfarben-Darstellung mit der Bandkombination 8-4-3 in QGIS 3.16. Quelle: Eigene Bildschirmkopie.
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© Copernicus Data 2019 =

Abb. 24. Durchsuchen der Verarbeitungswerkzeuge nach dem Rasterkalkulator in QGIS 3.16. Quelle: Eigene Bildschirmkopie.
© Copernicus Data 2019 »

Abb. 25. Berechnung des NDVI mit dem Rasterkalkulator in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019 =

Abb. 26. Graustufen-Darstellung des NDVI nach der Berechnung in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data
2019

Abb. 27. Symbolisierung des NDVI-Layers nach Klassen in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Abb. 28. Darstellung des farbig symbolisierten NDVI-Layers in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019
2

Abb. 29. Berechnung des NDWI mit dem Rasterkalkulator in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019 =

Abb. 30. Mit blauem Farbverlauf symbolisierter NDWI-Layer in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019
2

Abb. 31. Drag & Drop von Vektordateien im Shapefile-Format vom Windows Explorer nach QGIS 3.16. Quelle: Eigene
Bildschirmkopie. © Copernicus Data 2019 =

Abb. 32. Einladen eines Vektorlayers in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Abb. 33. Auswabhl der richtigen Shapedatei durch Angabe des Dateiformates im Windows Explorer. Quelle: Eigene Bildschirmkopie.
=4

Abb. 34. WFS-Dienst fiir Feldblockkataster auf der Webseite des Geoportal MV. Quelle: Eigene Bildschirmkopie. Landesamt fiir
innere Verwaltung MV, Amt fiir Geoinformation, V. K. Landwirtschaft und Forst - GeoPortal Mecklenburg-Vorpommern.
https://www.geoportal-mv.de/portal/Geowebdienste/Fachthemen/Landwirtschaft_und_Forst (2020). 2>

Abb. 35. Einrichtung einer neuen WFS-Verbindung in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Abb. 36. Auswahl der WFS-Layer einer neuen WFS-Verbindung in QGIS 3.16 Quelle: Eigene Bildschirmkopie. =

Abb. 37. Extrahieren einzelner Features aus dem WFS-Layer in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019,
© Landesamt fiir innere Verwaltung Mecklenburg-Vorpommern, Amt fiir Geoinformation, Vermessungs- und Katasterwesen
(2020) &

Abb. 38. Erstellen eines neuen Shapedatei-Layers in QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Abb. 39. Editieren neuer Features in einem Vektorlayer mit QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019 =

Abb. 40. Suche des Verarbeitungswerkzeugs ,,Layer reprojizieren“ mit QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus
Data 2019, © Landesamt fiir innere Verwaltung Mecklenburg-Vorpommern, Amt fiir Geoinformation, Vermessungs- und
Katasterwesen (2020) =

Abb. 41. Reprojizieren eines Vektorlayers mit QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Abb. 42. Raster auf Layermaske zuschneiden mit QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Abb. 43. Auf ein Polygon zugeschnittenes NDVI-Raster in QGIS 3.16. Quelle: Eigene Bildschirmkopie. © Copernicus Data 2019, ©
Landesamt fiir innere Verwaltung Mecklenburg-Vorpommern, Amt fiir Geoinformation, Vermessungs- und Katasterwesen
(2020) &

Abb. 44. Exportieren / Speichern eines Rasterlayers mit QGIS 3.16. Quelle: Eigene Bildschirmkopie. =

Abb. 45. Projektansicht / Karte als Bilddatei speichern mit QGIS 3.16: Eigene Bildschirmkopie. =

Abb. 46. Abspeichern einer in QGIS 3.16 generierten Bilddatei iiber den Microsoft Explorer: Eigene Bildschirmkopie. =
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